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RCtool 2.0 and later versions
This is the release of RCtool as of version 2.0 and later, now called Review Comments 
tool (formerly called REtool, i.e. Review Editor tool). RCtool is a data base and supports 
the management of IPCC review comments, designed for use in the 6th assessment 
cycle. RCtool is targeted to be useful for authors as well as review editors, but may also 
be of interest for other users, such as TSU staff, chapter scientists and in particular 
CLAs when organising the work on how to respond to review comments.

Find more on RCtool also at its home page:   www.sysecol3.ethz.ch/RCtool/

What you need

RCtool is available for free. It was developed using FileMaker Pro 16 Advanced 
(v16.0.6.600), yet, in its standard version, RCtool can be used independently  from 
FileMaker Pro Advanced (find details on this license in the nearby file ‘FMP 
Acknowledgements.pdf’). In its standard version RCtool cannot be modified. Thus 
RCtool is also released for FileMaker Pro Advanced (v14 or later), so that anyone who is 
in possession of such a license, can not only use RCtool but also modify it. We 
recommend to get in touch with the developers first if you plan to modify RCtool.

In addition to RCtool itself you also need a PDF reader to make good use of RCtool. 
Under Windows we recommend to use Adobe Acrobat Reader DC (default setting in this 
release) or Adobe Acrobat Pro DC. On the Macintosh we recommend the powerful open 
source pdf reader Skim (default setting in this release). Unfortunately the functionality of 
‘Adobe Reader’ on the Macintosh is limited. Therefore, it is recommended to work with a 
better PDF reader such as Skim or then Adobe Acrobat. 

First Time Installation

The core of RCtool consists of three files:

! ‘RCtool‘!! ! the RCtool application
! ‘RCtool-main’! (extension ‘.fmpur’) storing the review comments
! ‘RCtool-textlinks’! (extension ‘.fmpur’) storing meta data to link comments with PDFs

For a quick start, focus on bold text in 
the paragraphs marked with a green circle:    
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  To install RCtool anew on your system simply copy the RCtool folder as released 
to your disk into any folder of your choice and name. Please work from the provided 
subfolder structure and do not change it (unless you know well what you are doing). Use 
for each report a different  copy of the main RCtool folder should you work with 
more than one IPCC report. On a Mac the main RCtool folder looks similar to this:

The red rectangle encloses the main files consisting of the RCtool application (here 
having a bluish icon) and the two data base files ‘RCtool-main.fmpur’ and ‘RCtool-
textlinks.fmpur’. 

The green rectangle encloses the so-called RCtool work folders, to receive the draft 
specific files for the Zero Order Draft (ZOD), the First Order Draft (FOD), the Second 
Order Draft (SOD), and the Final Government Draft (FGD).

The blue rectangle encloses the folder containing the so-called TAT-textlinks files. They 
are to hold the meta data on the structure of each draft and are ready to receive those 
meta data in form of a spreadsheet for each product of the IPCC 6th assessment cycle.

Under Windows the same principle of organizing the data applies as shown above, but 
there are many  more files. First, it is recommended to unpack the downloaded zip on 
your Desktop. After unpacking the zip  folder you need to locate the actual RCtool 
application within the unpacked folder. It resides within a subfolder named ‘RCtool’ 
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within which all files needed are actually stored. The main files (red rectangle) within 
your RCtool folder should look similar to the following: 

Double-click the application RCtool.exe. If you are invited to install RCtool do so by 
installing RCtool at a final destination, which is best chosen within your Documents 
folder. If asked, create an icon on your desktop  and allow for an entry in your startup 
menu. If RCtool was installed at such a final destination different from your desktop, use 
only that one and discard the original unpacked folder together with the downloaded zip 
file.

  It is recommended to always first open the RCtool application, e.g. by a 
double-click onto the application’s icon. Never try to open the data base file ‘RCtool-
main’ (with extension ‘.fmpur’). Note, opening RCtool will always open also its related 
data base file, i.e. ‘RCtool-main’, the main file you work in.

Upon launching an RCtool never used before you are asked the question whether you 
use RCtool for the first time or whether you have used it before and an older version of 
RCtool has been backed up or exists otherwise on your system:

Let us assume it is your first use. Click that button. You should then make two settings 
right away: Tell RCtool your initials and choose your IPCC report:

1.   Tell RCtool your initials and your role. Under Windows you are asked for your 
name right away when you launch RCtool for the first time. If you missed that 
opportunity or wish to check once more what you then entered choose menu 
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command ‘Edit -> Preferences...’ and do the same as described below for the 
Macintosh. On the Macintosh always choose the menu command ‘RCtool -> Edit -> 
Preferences...’. A dialog similar to the following opens

                    

Click radio-button ‘Other’ and enter your initials (mine’s being ‘AF’). You can enter 
here whatever you want, but for brevity reasons I recommend to enter only initials, 
not an entire name, but of course initials that tell you apart from your colleagues. 
This needs to be done only once.

Secondly you are asked about your role:

               

Let’s assume you are a review editor and you then enter RE. If you are neither a RE 
nor an Author, e.g. TSU staff, enter Other.
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2.   Tell RCtool which IPCC report. In the top left corner of the RCtool window you 
see a pop-up menu now showing the current mode, i.e. ‘Edit Mode: Standard’:

                         

This pop-up menu is important for you. It lets you control the so-called “modes” of 
RCtool. Let’s switch to another mode by clicking onto the current mode ‘Edit Mode: 
Standard’ and choosing in the shown pop-up menu the new mode you intend to go. 
Here we choose ‘RCtool Settings’:

                                 
                        
The chosen mode ‘RCtool Settings‘ gives you an entirely new view to RCtool: It 
allows you to specify several critical settings. For the time being there is only one 
setting to make, a setting which is of fundamental importance: Choosing your IPCC  
report. You find in the top right corner the factory set report, i.e. SR1.5 (left part in 
figure below). Behind ‘SR1.5’ is actually just another popup menu.
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Click on ‘SR1.5‘ and the pop-up menu shows, with the current report being checked 
(middle part in above figure). To change to another report, say ‘SROCC‘, simply 
choose that report. The top right corner and the window title should then have 
changed to the new report, say ‘SROCC’ (right part in above figure). From now on 
RCtool knows with which report you are working. Again, this needs to be done only 
once.2 

Since we assume here that you are a RE, you will also be asked about your chapter 
for more convenient use of RCtool:

                 

Once you told RCtool all this, you are ready to go. You need not repeat above 
settings when you merely update. In such a case it is recommended to click on that 
button instead of ‘First use’ and automatically retrieve all those data from the last 
version of the data base you used.

This completes the first installation and best go back to ‘Edit Mode: Standard’.
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Give RCtool the data: For RCtool to meaningfully  work, you need to import data. All 
needed data are provided by first populating the RCtool work folders (green rectangle in 
first figure) with files and then secondly  import those data into RCtool by executing a 
dedicated menu command from within RCtool. The needed files are provided in a draft 
specific manner and that is why you have for each draft a subfolder and within that 
folder for every category of data again a dedicated subfolder. This is illustrated in the 
graph below for the First Order Draft (FOD), the RCtool work folder ‘2-FOD’. That folder 
is structured by containing following subfolders:

For each category  of data, i.e. PDFs of the draft texts, Review Comments, Author 
Responses, RE Annotations, plus exported RCtool Core Data exists a dedicated 
subfolder. Please populate now these subfolders with files so that RCtool can use them. 
It is recommended to stick to the given folder structure and not to change any folder 
names. You can add your own subfolders or files, but please keep the provided folders 
unchanged.

 Importing Review Comments: Upon first launch, the data base of RCtool as 
released is empty and contains no review comments and also no meta data. The reason 
is that those data are confidential and can’t be distributed with the freely  available 
RCtool. To get the review comments of a particular draft you need to perform following 
two steps:

1. Populate the respective work folder (green rectangle), i.e. for Review Comments the 
subfolder named ‘z1-Review Comments’ with the spreadsheets containing the 
review comments. You need to do that for every draft you work with. Do not change 
the names of those files. Simply move or copy the files as received from TSU or 
downloaded from the Data Management System (DMS). Below the folder as it looks 
once you have populated it with all review comment files for the FOD of SROCC:
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You see there files for each chapter, the Cross Chapter Box 5 and the review 
comments pertaining to the entire report. 

2. Import the wanted data, say for chapter 2 into RCtool. To this end choose from 
within RCtool the menu command ‘Import Review Comments from 
spreadsheet...‘

               

and follow the instructions, i.e. specify you want the data for the FOD and chapter 2. 
If all goes well you should have now all 1447 Review Comments on chapter 2 of the 
SROCC FOD in RCtool and the RCtool window should look similar to this
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You are now ready to work already with those comments. Read them, enter Author 
Responses or as Review Editor (RE) annotate the comments and/or the Author 
Responses (if already available). You can search in every section of the comments 
etc. etc. Submenu ‘Comments -> Find comments’ provides many commands for 
quickly finding specific comments. Please consult the guide to learn more about the 
many features of RCtool.

Typically you do a second import, i.e. you import also the comments for the entire 
report. When you are asked for the chapter enter the abbreviation ALL. You can of 
course do imports for other chapters or other categories of data as supported by 
RCtool.3 Please note in this context the following is important to remember always: You 
should import the review comments only once. Note also, RCtool lets you freely  import 
review comments in whichever order and as many times you wish. On the other hand, to 
work well, RCtool should contain every  review comment only once or things may get 
messy. RCtool warns you, should you encounter such a state where the same comment 
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3 Currently TSUs change the structure of comments spreadsheets all the time. Unfortunately this may 
result in REtool to fail to import the data correctly. E.g. REtool may refuse to import any data or some data 
end up in the wrong place, e.g. reviewer’s name ends up as comments etc. If you encounter difficulties in 
importing review comments REtool offers a Pro Mode (Help -> Set Pro Mode -> On) you can resort to 
more advanced commands or contact the developer (see the home page of REtool) and ask for a new 
version (if that is the case please provide also the spreadsheet you tried to import). Otherwise, should you 
own a license for a compatible FileMaker Pro Advanced (v14.0.6 or later), you can easily adjust the import 
command for the actual spreadsheet structure yourself (again the developer is happy to help).
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is present more than once, so-called duplicates. Advanced techniques4 let you fix such a 
state. Yet, if you stick to the rule to import the same Review Comments only once (or 
replace the existing ones), everything should work smoothly. 

Note also,  the more comments you store at a time, the slower some processing may 
become. For REs it is therefore recommended to store only the comments pertaining to 
the chapter for which you are RE and accumulate the comments only as drafts become 
available.

Note, importing data into RCtool is in general quite safe, since RCtool makes 
automatically by default always first a backup from your data base. This happens just 
before it imports new data (those backups reside in the subfolder ‘RCtool data 
archives’). In case anything goes wrong, It is highly  recommended to quit right away 
RCtool and to discard the current copy of ‘RCtool-main’. Then move a copy of the just 
backed up file to the working location and rename it by  taking out the automatically 
appended date and time information from the file name. Make sure the name of the thus 
restored data base file is ‘RCtool-main.fmpur’. Open application RCtool once more and 
you should have resumed exactly where you were before the import. 5

Jumping to PDFs: A strength of RCtool is to be able to jump to a draft text location as 
referenced by a review comment. Similarly  RCtool can jump to the draft text by an 
element in the ‘Table of Contents’ (TOC) view of RCtool. First, provide the PDFs as 
described next.

 Provide the PDFs: Move or copy the PDFs of the draft texts you are working with to 
the draft dedicated subfolder ‘pdfs’ within the dedicated RCtool work folder (green 
rectangle). Again let us do this for the SROCC. Simply store the PDFs of the ZOD in 
subfolder ‘1-ZOD/pdfs’ and those of the FOD in subfolder ‘2-FOD/pdfs’. The subfolders 
‘pdfs’ may then look similar to these, each within its respective RCtool work folder:
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4 Available in the Pro Mode (Help -> Set Pro Mode -> On) under submenu ‘Scripts -> Resolve Conflicts

5 There are several other techniques to accomplish the same. E.g. menu command ‘File -> Backup and 
Updating -> Restore data from backup or previous version (update)...’ can help to restore a previous state 
of RCtool. In general your data are generally safe and RCtool is very flexible in importing and exporting 
data.



Now, RCtool by default can’t work with the PDF names shown to the left because they 
are named in a non-standard manner (and it may also well be your files are actually 
named very differently than those shown above). Simply rename the PDFs so that they 
can be recognized by RCtool. The rule is that chapter PDFs should be named ‘Chapter 
1.pdf’, ‘Chapter 2.pdf’, ‘Chapter 3.pdf’ etc.6 7  The cross chapter box is named as CCB5. 
After renaming the pdfs, the folder should look similar to the one shown on the right 
above.

Settings for the PDF Reader: Finally you need also to check whether the pdf reader on 
your system you intend to use is made known to RCtool. To this end visit mode ‘RCtool 
Settings’ (pop-up menu next to the word ‘Mode’ in the top  left corner of the window) and 
choose the appropriate settings on the top  of the page in section «Settings for accessing 
PDFs of draft documents». 

Now, you should already be able to jump from a comment to the referenced text in the 
PDF.8  Use the dark buttons in the top right corner of every comment:
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6 In addition to chapters further reserved names are: SPM, TS, CCP1 .. CCP10 plus CCB, CCB1 .. CCB5.

7 Hint for the advanced: On the Macintosh you can also use the Unix symbolic links with the proper name, 
i.e. instead of the provided folder ‘pdfs’ having a symbolic link with the identical name, but that points to 
whatever folder where you store the PDFs. Symbolic links work also for individual PDFs. You can also 
change the names of those subfolders, given you do at the same time modify the settings in REtool 
accordingly (read on). In general make sure you have consistent settings as shown in mode ‘REtool 
Settings’ and the actual subfolders and PDF names you are using. Visit mode ‘REtool Settings’ (pop-up 
menu next to the word ‘Mode’ in the top left corner of the window) and make sure the strings in section 
«Location of draft PDFs» match accurately the folder names you are actually using on your system.

8 Under Windows you need to launch the PDF Reader first manually. Once open, the jumping to PDF’s 
should work.



Above example is not that exciting, since the comment pertains to the whole chapter 
and you jump then only to the first page of that chapter. Jumping is most helpful if you 
want to go to particular sections within the draft. Scroll down to another comment 
referencing a particular paragraph or figure and try  it out. Clicking on the same button 
should immediately bring you to the referenced section in the PDF.

RCtool can also jump  from a table of contents view to corresponding pages in the PDFs. 
Switch to the mode ‘Table of contents’ by using the pop-up  menu in the top left corner, 
i.e. leave the mode ‘Edit Mode: Standard’ and go to the mode ‘Table of contents’. This is 
simply another view (in FM jargon called a layout) to your data in your data base. Here 
you see no review comments. Instead you can see here a table of contents of the report 
you work with and jump  from every listed item to the corresponding location in the PDF. 
However, because of first use, data are missing and the table of content is empty. 

To get the table of contents populated, you need first to import the needed meta data 
into the data base file

! ‘RCtool-textlinks’! (extension ‘.fmpur’)

Note, the purpose of ‘RCtool-textlinks’ is to store the necessary  meta-data on the draft 
structure. This enables the jumping to referenced texts, figures, footnotes, tables, FAQs 
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etc. in the PDF via the Table of contents view.9  Open the auxiliary file ‘RCtool-textlinks‘ 
by clicking on the button in the middle of the toolbar at the top of the window labelled 
‘Open RCtool-textlinks’. 

Note, the needed meta data are of course report and draft specific. They typically need 
to be updated as each draft becomes available. The meta data are available in form of 
spreadsheets. Again you should be able to get those from the same sources you have 
obtained the review comments.10

 Import  the needed meta data in ‘RCtool-textlinks’: As released, file ‘RCtool-
textlinks’ is empty and contains no meta data. To obtain the needed data, switch to 
mode ‘Table of contents’ (pop-up menu next to Mode in top  left corner) and click on the 
button ‘OpenRCtool-textlinks‘. Note, this is something you do typically  only  rarely, since 
the window for the file ‘RCtool-textlinks’ is normally closed and accessed by  ‘RCtool-
main’ in a hidden manner behind the scene only. 

Similarly as with Review Comments you need to populate the dedicated folders in the 
RCtool work folder, the TAT-textlinks subfolders (blue rectangle in first figure) with the 
spreadsheet files that contain the meta data.  Make sure that for each draft and all 
chapters you wish to work with you have all the corresponding files available. As of this 
writing the SROCC has advanced to the FOD. Meta data available so far are for the 
ZOD and the FOD. Perform these two steps:

1. Move (or copy) following two files to the SROCC subfolder within the ‘0-TAT-textlinks 
‘folder (blue rectangle in first figure):
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9 Note, the use of the Table of contents view is optional. The jumping to a location in the PDF of a draft as 
referenced by a comment and described above works also without the textlinks. However, certain features 
in the standard view are also affected by the absence of textlinks. E.g. finding comments by section 
(menu command ‘Comments ->  Find comments -> Find comments for a section/section range...’) 
requires also the presence of the textlinks. Similarly the pop-up display of the title of a section when 
hovering with the cursor over the top right corner field requires also the presence of textlinks.

10 Those spreadsheets are outputs from TAT (Text Analysis Tools). TAT is released separately from 
REtool.



              
Your TAT-textlinks subfolder for SROCC should then look similar to above. Best keep 
those files present all the time and add more files as more drafts, e.g. the SOD and 
FGD meta data files describing their content, become available.11 

2. Import 12 for the ZOD and the FOD the meta data into ‘RCtool-textlinks’ by 
choosing menu command ‘Scripts -> Import TOC from spreadsheet...’, select 
the wanted spreadsheet once for the ZOD and then for the FOD by appending the 
FOD to the data base.13

 If all looks fine, close the window.

This needs to be done only once and such a step is to be repeated only as the SOD 
becomes available. Should you accidentally try to import the same data a second time, 
following alert appears:

Note, the import mode Replace replaces whatever data are already present in ‘RCtool-
textlinks’ for the draft. In this case you are actually safe to replace the existing data to 
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11 Note, while working with several reports requires to have another copy of REtool, the TAT-textlinks 
folder is the only thing that can be shared among reports and remains always the same. Above shown 
folder structure supports all products of the IPCC 6th assessment cycle.

12 This step is optional if no spreadsheet with the meta data is available

13 If something goes wrong, simply start all over by replacing the data.



avoid having the entire meta data twice in the data base. Such a state is always to be 
avoided.14

Once the meta data are imported, the Table of Contents should now be available to you. 
It should look similar to this (here illustrated for the SR1.5):

The pop-up menus on the top allow you to focus on report elements such as chapter 
sections by level in the hierarchy, or only on figures, tables, boxes, footnotes, FAQs etc. 
Each element listed (e.g. in above figure ‘ES 1   Executive Summary (Chapter 1)’) is 
also a button allowing you to jump  right away to the referenced PDF section/page. This 
can be particularly handy e.g. for TSU staff or anyone else analyzing an entire report.

There is an important side effect of having the meta data of a report available. This 
allows you to also use the second button in the top right corner of each comment to its 
max. By default this button shows SOD when you work with the FOD. 
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14 The mode Append allows to accumulate data. Use it when you import partial data, e.g. during importing 
of Review Comments, one chapter after the other. The mode Replace is only recommended whenever 
you wish to start from scratch. In the case of textlinks, where you normally import from a single file the 
meta data of the entire draft, the mode Append makes little sense.



Is this button useless until the SOD becomes available? No. When you are working with 
the FOD, you typically also have the ZOD available. Above you just imported the meta 
data also of the ZOD. You can now use those just imported meta data to compare the 
FOD with the ZOD. Simply switch to looking backwards for comparisons. Go to mode 
‘RCtool Settings’ (top left corner pop-up menu) and change the ‘Comparison mode’ from 
forward to backward:

Back to ‘Edit Mode: Standard’ (top left corner pop-up  menu) the second dark button in 
the top right corner of every Review Comment shows now ZOD and no longer SOD: 

Thanks to the meta data on the ZOD just imported, that button is now fully empowered15 
and can jump to the corresponding section or other draft element in the ZOD. Say  you 
look at a comment on Figure 2.5. Thanks to these buttons labelled FOD and ZOD you 
can now jump to Figure 2.5 in both the FOD as well as the ZOD. RCtool knows where 
the two Figures 2.5 are and helps you to compare the two drafts next to each other. 

The guide16  contains at the begin a figure that gives you an overview of those 
relationships. RCtool can at any time compare two drafts, either in the forward or 
backward looking mode and hereby compare every draft with every other draft.

In RCtool-textlinks installed meta data does also support the pop-up  display of section 
titles and other explicit information about the element currently shown in the top right 
corner. Here the example of a text reference starting at page 2, line 96 and ending at 
page 2, line 103. That text belongs to section 1.2.1 and the title of that section becomes 
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16 The REtool guide is available from the home page of REtool (http://se-server.ethz.ch/REtool/index.html) 
as well as from within REtool (menu ‘Help -> Open REtool User Guide’)

http://se-server.ethz.ch/REtool/index.html
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visible in the yellow pop-up  menu when hovering over the field where the cursor is 
shown:

Finally, there are also a few menu commands such as ‘Comments -> Find comments -> 
Find comments for a section/section range...’. To really work this command requires also 
that the TOC meta data are installed in RCtool-textlinks. 

The installation of the meta data in RCtool-textlinks is in general optional. Aside from the 
features described above the core functions of RCtool work already well without having 
the meta data installed.

 To check the entire installation scroll to any  review comment and click on the 
buttons in the top  right corner of the comment. Under Windows you may need first to 
launch the PDF reader yourself. Normally any click on any of the two dark buttons in the 
top right corner should open the PDF at the wanted page. This should also be the case 
in the mode ‘Table of contents’ (use top  left corner pop-up menu). Clicking on a listed 
section, figure, or table should open the PDF at that section, figure, or table etc.

This completes the basic installation of RCtool.

Please consult the guide to learn about the actual use of RCtool. Note, there is a menu 
command available to open the guide: ‘Help  -> RCtool User Guide’. Additionally you can 
also visit the web page of RCtool using the menu command ‘Help -> Visit RCtool web 
page’. That web page offers this Read Me, the guide, and FAQs. The latter I plan to 
update as I receive feedback from you. You find there also under section ‘Home & 
Downloads -> Links’ a link to send me an e-mail.
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Updating RCtool

 Updating your installation of RCtool with a new version consists of following 
three steps: 

1. backup
2. replace old with the new files contained in the update
3. restore the data from the just made backup

1.  Make a backup of your current RCtool data base by using the menu 
command ‘File -> Backup and Updating -> Backup data base RCtool (main, 
textlinks)’:

Note, a full backup of both files ‘RCtool-main’ and ‘RCtool-textlinks’ (both typically 
with the extension ‘fmpur’) are then created with a date and time stamp appended to 
the file name. Those backup files are always stored in the subfolder ‘RCtool data 
archives‘. That folder came with the first time RCtool release. Having made a backup  
that folder may look similar to this 17
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having imported some data (unless you should have unchecked the preference ‘Always backup’).



        

2.  Move or copy any file that came with the update to the RCtool folder by 
replacement. RCtool functions only correctly if file names are not changed. Thus it 
is important to replace any old file having the same name with the new one. You 
have made a backup in the first step, thus there is no risk of data loss. 

a)  Replace the old RCtool-main with the new one. 
! The new file contains the new version of the RCtool data base and note, 
no new RCtool application is needed for an update. But that new RCtool-main file is 
empty, i.e. it contains no data, no Review Comments, no Author Responses, and no 
RE Annotations. Therefore while updating it is recommended to restore from the last 
backup, i.e. to perform also the next step.

b)  Replace the old RCtool-textlinks with the new one. 
! Remember, step 1 has already made a backup of the data that were 
stored in the old RCtool-textlinks.

c)  Move or copy the new RCtool_User_Guide to the RCtool folder. To avoid 
confusion I recommend to delete at this point the old user guide.18

d)  Replace the old ‘RCtool Read Me.pdf’ with the new one.

3.  The new RCtool data base is empty, it contains no data, only a new functionality. 
To restore the data simply launch the application RCtool. Since it is empty, it will 
ask you following question:
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Clicking on button ‘Updating’ launches a full restore process. Please follow the 
instructions. This process restores all data from the backup files you select. E.g. in 
step 1 you created the backup file you now select to restore from during the update

         

Note, this restores not only the data from RCtool-main, i.e. Review Comments, 
Author Responses, RE Annotations, and RCtool settings, but also the data from 
RCtool-textlinks, the Table of Contents (TOC) meta data allowing you to link data on 
the structure of the draft with all other RCtool data. 

At the end of updating you get a summary of what was restored similar to this:

           

This means there are 11,031 Review Comments, 6,981 Author Responses, and 1,190 
RE Annotations in total present in your data base, given as a number triple delimited by 
a vertical bar (‘|’). The sum of these, the so-called 19,202 records is given in the 
parentheses behind each triple. Below you get how these records distribute for all four 
drafts, a triple for the ZOD, FOD, SOD, and FGD each, again each time followed by a 
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record total in parentheses. The legend at the bottom is a reminder how to read the 
sequence of numbers for each number triple. Given you started from an empty data 
base, this means all those 19,202 records were restored from the backup. The old data 
can now be used exactly as they were in the new RCtool offering a new functionality.
Alternatively, you can also click ‘First use’ despite updating and nothing is lost. You can 
execute the data restore yourself by using menu command ‘File -> Backup and 
Updating -> Restore main data from backup or previous version (update)...‘ 

During the update RCtool may detect problems that were present in your original data 
base. It is recommended to fix issues right away as RCtool invites you. If there remain 
difficulties please consult the guide (sections «Resolving conflicts from redundancies 
(duplicates)» and «Importing data via Pro mode!»).

If you clicked ‘First use’ in step 3) nothing is lost should you wish to go back to your 
previously used RCtool data. You can execute the data restore yourself by using menu 
command ‘File -> Backup and Updating -> Restore main data from backup or previous 
version (update)...‘

The restoring should succeed and as a result all your data as previously stored within 
file ‘RCtool-main’ should now be present again in the new version of your RCtool data 
base. Note, this includes all RCtool settings, including old preferences that may deviate 
from default, so-called factory settings. You can overwrite your settings anytime by 
clicking on the button ‘Factory Reset’ in mode ‘RCtool Settings’ to resume an initial 
factory state of all settings. IMPORTANT: Note, this may require to choose your report 
and preferred chapter once again.

If you clicked button ‘First use’ RCtool-textlinks is also empty, i.e. it contains no data.19 
To restore its data use menu command ‘File -> Backup and Updating -> Restore 
textlinks data from backup or previous version (update)...’: 
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In some cases, e.g. at the stage of the ZOD or FOD, it may be even easier to quickly 
reimport all the meta data you work with from the spreadsheets by using the same 
commands as you used during the first installation for each draft you work with. To this 
end you need first to open the file ‘RCtool-textlinks’ by switching to mode ‘Table of 
contents’.

                                          

There open the auxiliary file ‘RCtool-textlinks‘ by clicking on the button in the middle of 
the toolbar at the top of the window labelled ‘Open RCtool-textlinks’:

                     

Then choose menu command ‘Scripts -> Import TOC from spreadsheet...’
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That should suffice and all meta data should be available again, similar what you would 
obtain when restoring from a previously backed up file. However note, you must not 
simply duplicate the backup file ‘RCtool-textlinks--backup-xyz.fmpur’ and rename it to 
‘RCtool-textlinks.fmpur’. Albeit the data stored in the data base have not changed, the 
data base’s functionality may well have changed from the previous version. Understand 
that the restore transfers only the data, but not the functionality of the RCtool data base, 
which can never be transferred.
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Additional and optional installation steps 

Finally  to use the new archiving feature fully, a little shell script needs to be made 
available to RCtool on the Macintosh. It is best copied/moved once to the ~/bin folder 
(create this folder in your home folder, if it does not exist yet on your Macintosh). This 
shell script ‘fixTABdelimFMExportForUTF8.sh’ (chmod 775 or 777) is executed only 
when you archive some data from RCtool to a text archive, not when exporting to Excel 
files. Thus its need is likely to be rare. Aforementioned shell script is installed once only 
and needs not be reinstalled with every update of RCtool. If you use RCtool on a 
Macintosh it is recommended to install this shell script.

Text Analysis Tools (TAT): Meta data as needed to jump to PDFs can be generated 
from the PDFs themselves. This is the purpose of the Text Analysis Tools (TAT) that are 
also available from the same location as RCtool. The installation of TAT20 is optional and 
RCtool works also fully without it. TAT serves only to extract the meta data from a draft, 
making hereby the core of RCtools (RCtool-textlinks and RCtool-main) fully  functional. 
Thus TAT is needed whenever the spreadsheet with meta data for ‘RCtool-textlinks’ is 
missing and/or not yet available. TAT and RCtool can be used independently, thanks to 
the technique to exchange meta data only  in form of a spreadsheet: TAT produces the 
spreadsheet, ‘RCtool-textlinks’ imports it. Yet, TAT’s functionality is of course essential 
for RCtool to link a draft’s PDFs to RCtool and hereby enhances RCtools’ usability 
greatly. Note, TAT comes with its own Read Me file.
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standard shell scripts making good use of the powerful Unix tool awk and a FileMaker based post 
processor to generate the spreadsheets that go into the TAT-textlink subfolders (blue rectangle in first 
figure).



Using RCtool

The help file 

! RCtool_User_Guide-2.0.pdf

explains the basic use of RCtool. The application RCtool offers also a menu command 
to open that help file in the RCtool help menu (‘Help -> RCtool User Guide’).21 

af, 18.Apr.2021
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Version history

• 2.3! Version 2.3 (Dec 2021) contains following improvements:
• Support for WGII Final Government Draft (Final Draft, FGD) including 

first draft of SPM and TS
• Renamed menu command “Show comments with unresolved RE 

conflicts (red)” to “Show important comments with unresolved RE 
conflicts (RE priority ≥ high)” to make the intention of the search 
clearer as red comments result only when the RE work for the 
comment has been completed. 

• Adding menu command “Show comments without RE conflicts”
• Reordering of RE history menu commands according to same 

principles as used for the other “show comments...” commands.
• “Sort by RE priority” now sorts according to highest RE priority in case 

where REs differ in their priority assessment
• Minor enhancements for imports from collaboration into quarantines 
• Menu command ‘‘Find/Fix inconsistent page or line numbers…” now 

fixes problematic text references in one go and returns the entire 
result message in the clipboard

• New menu commands “Merge RE Annotations” and “Merge RE 
Annotations for current set…”. They merge the RE Annotations for a 
RE history as contributed by a RE team into the topmost final RE 
Annotation marked by the prefix “RE HISTORY:   “ either for the 
current Review Comment or the set of currently shown Review 
Comments.

• Menu command “Comments -> Find comments -> by responsibility...” 
does now also result in the Review Comments that have token ‘AllLAs’ 
or ‘AllREs’ assigned as the responsibility.

• New menu commands for the set “Comments -> Show comments” -> 
“by responsible author”, “by contributing author”, “by responsible RE”, 
and “by contributing RE”. Commands “by responsible author” and “by 
responsible RE” result in the same set as the former “Comments -> 
Find comments -> by responsibility...”.

• Polished use of text colors for RE evaluation field.

! and following bug fixes:
• Pro mode: Importing RE Annotations from any spreadsheet works 

again
• Show comments without RE history fixed
• Finalisation buttons to finalise author and RE histories work again
• Tooltips fixed and polished for buttons available in history mode
• Quarantine imports handle RE Evaluation value “Barely acceptable” 

now correctly
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• Display of Who information made more reliable also in cases of 
missing data in imported RE Annotations

• Omitting multiple confusing alerts announcing the switch to quiet mode 
that could be encountered in certain circumstances when using menu 
commands “Finalize Author Responses for current set…”, “Finalize RE 
Annotations for current set…”, and “Merge RE Annotations for current 
set…”

• Using Author Responses from the quarantine (button ‘Use these 
Author Responses’) works now also without repeating alerts when the 
Author Responses are finalised  

• 2.2! Version 2.2 (Nov 2021) contains following improvements:
• Support for importing WGII Author Responses to SOD Review 

Comments
• Improved handling of the optional section information. Such 

information describes to which section, figure, or table etc. a Review 
Comment pertains.

• Simplifying import dialogs for Review Comments and Author 
Responses by asking for the import mode (add or replace) only when 
needed. The user is now asked only in those cases where data of the 
kind to be imported are actually already present in the RCtool data 
base.

• Quarantine imports are enhanced so that the primary key 
‘RevCommID’ needs no longer be imported. To facilitate the use of the 
quarantine a new button ‘Fix’ (blueish) has been added to force a fix of 
the currently shown records, e.g. for the primary key.

! and following bug fixes:
• When importing either Review Comments or Author Responses or RE 

Annotations from a spreadsheet the user is no longer asked twice to 
select the very same spreadsheet

• Importing of Author Responses from any spreadsheet no longer fails 
when the user forgets to import also the chapter column into field 
‘Chapter_Info’

• Fixing wrong result display of how many Author Response records 
were imported in case of importing Author Responses for multiple 
chapters

• Shown records count correctly updated after executing menu 
command “Hide before or after current comment...”

• Button ‘Delete some...’ in the import quarantines works again
• History flags (purple little square in top right corner of Author 

Responses and RE Annotations labelled by a white H) show now 
again
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• 2.1! Version 2.1 contains following improvements:
• The menu command “Find critical comments...” has been enhanced to 

work also with SPM Review Comments.
• It offers export hubs for authors and REs. These export hubs offer in 

analogy to the import quarantine a place from which to generate 
spreadsheets from the data in the RCtool data base in a flexible 
manner. This can be used to exchange spreadsheets with colleagues 
during responding to comments by authors or when REs evaluate how 
authors have addressed the comments. The user can determine on 
the fly which data columns to export in which sequence. Only when 
e-mailing such spreadsheets is the export hub skipped. Use it first 
without e-mailing to determine the format. Once that’s done use the 
e-mailing commands to conveniently send the spreadsheet to the 
colleague. Once no specific colleague is targeted with the spreadsheet 
export it anonymously and the final spreadsheet version is produced 
(mode Topmost). This feature is useful e.g. once all Author Responses 
are done and the spreadsheet is to be submitted to the TSU.

• The export hubs are automatically reached when executing the two 
topmost menu commands in the submenu “E-mail or Export for 
collaboration” (“E-mail spreadsheet with Review Comments...” and 
“Export Review Comments...”). They can also directly be reached via 
submenu “View -> Go to Layout -> Exports (Export hubs)” similar to 
the previously available submenu “View -> Go to Layout -> Imports 
(Quarantine)”.

• Introducing new show comments commands “Show important 
comments with differing RE priorities (≥ high)” and “Show comments 
with differing RE priorities”

• The working with sets of comments is now supported by following new 
menu commands:

(i) “Copy comment #s before and after current comment into clipboard”
(ii) “Extend current set by the clipboard listed (comma separated)” 
(iii) “Hide before or after current comment...”

The former (i) works very similar to the existing menu command “Copy 
comment #s as list into clipboard (comma separated)” except for 
producing two comma separated lists. The first set (or list) contains 
the numbers of all comments that come before the currently selected 
comment (the latter being included). The second set (or list) contains 
all comment numbers of the comments that come after the currently 
selected comment (the latter being excluded). This helps to easily split 
large, e.g. sorted by RE priority, sets into two subsets. 
The second new menu command (ii) allows to extend the current set 
by those comments that are listed by their numbers in the clipboard. 
Of course RCtool assumes those numbers are provided in form of a 
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comma separated list.
The third new menu command (iii) can hide all comments before or 
after the currently selected comment. This works also from related 
tables, i.e. tables showing Author Responses or RE Annotations, even 
in the quarantine. In the former cases the review comment related to 
the currently selected Author Response or RE Annotation is 
considered to be the relevant comment defining what is before or after. 
In cases of the quarantine, the actually shown set of records from the 
quarantine are hidden.

• During imports to the quarantine of author decisions, RE priorities, and 
RE evaluations from spreadsheets, all values are checked for 
misspellings and are mapped to the RCtool conventions whenever 
possible. This makes status displays more consistent, facilitates 
searching, and overall statistics results become more accurate.

! and following bug fixes:
• Show comments commands such as “Comments -> Show comments 

-> that are important (RE priority ≥ high)” and similar now work again
• More consistent behavior of show comments commands with respect 

to “with” vs. “without” variants, i.e. each pair finds sets that 
complement each other also in the presence of complex histories (1:n 
relationship fully considered).

• “Find or constrain by clipboard list (comma separated) (internal)” and 
the clipboard related similar menu command work all again in the 
quarantine layouts

! There are no known bugs.

• 2.0.2! Version 2.0.2 contains following improvements:
• New simple export format for sharing Review Comments 

spreadsheets with a colleague and rearranging the related menu 
commands to offer the simple format first: (i) “E-mail spreadsheet with 
Review Comments to an author/RE colleague...”; (ii) “Export Review 
Comments to Excel for an author/RE colleague...”; (iii) “E-mail 
spreadsheet with Author Responses/RE Annotations to a colleague...”; 
(iv) “Export Author Responses/RE Annotations to Excel...”

• Helper menu commands “Set priority to ‘low’” and “Set priority to 'very 
low' (editorial only)’” set the RE evaluation to ‘Do not know’ if not yet 
set.

• New menu command “‘Go to comment with number...”
• Enhancing menu command “Find critical comments…” to detect even 

more Review Comments. As this may result in more false positive, the 
algorithm excludes any Review Comments that have been marked by 
a RE for having a low priority or be even only an editorial comment. 
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Any Review Comments marked manually as being critical are now 
also included in the search using this menu command.

• All authors or REs involved in the preparation of an Author Response 
or RE Annotation are shown in the Who field in chronological order 
starting from the person initially assigned to be responsible till the last 
person finalizing

! and following bug fixes:
• “Finalize RE Annotation” did not work in case of RE conflicts
• Button ‘Delete all’ in quarantine does delete also when all records are 

currently shown
• E-mail for collaboration to a colleague creates again the E-mail and 

not only the spreadsheet

• 2.0.1! Version 2.0.1 contains following improvements:
• Helper menu commands “Mark for being critical” renamed to “Toggle 

comment for being critical” and “Mark comments in current set for 
being critical...” renamed to “Mark comments in current set for being 
(not) critical...” and changed behavior accordingly

• Adding new Helper menu command “Return to previous layout”
• Pro mode menu commands “Show related Review Comments”, “Show 

related Author Responses”, and “Show related RE Annotations” from 
menu “Manage data base” can now be used in more views or layouts, 
including the quarantine layouts.

• Improved advanced search so that search criteria can be entered into 
all fields including Who field

• The Who field button can now toggle finalization and does no longer 
just clear it for increased efficiency

• Imports into the quarantine can ask for a field dialogue to flexibly 
import spreadsheets shared with colleagues when column 
arrangements were changed. A new button in the quarantine’s tool bar 
allows to toggle this behavior, i.e. import as in previous versions 
without or with a the field dialogue.

• E-mailing or Exporting Review Comments to Excel for a colleague 
author or RE creates a simpler spreadsheet with less columns. Only a 
minimum of only internally used columns are exported. This should 
facilitate manual work with such spreadsheets while still supporting 
any later reimport into RCtool.

• 2.0! Version 2.0 is a major update and replaces all previous versions as it includes 
a renaming step from REtool (Review Editor tool) to RCtool (Review 
Comments tool). This is necessary as the targeted users are no longer just 
review editors but on an equal footing authors as well as TSU staff or 

31/36



whoever wishes to manage review comments, e.g. while responding to 
them. In addition following improvements were made:

• Support for all drafts up to this point in time, including improved 
handling of special “chapters” such as Atlas, CCPs, and glossaries. 
This includes notably support for importing of FOD Author Responses 
and SOD Review Comments from WGII.

• Enhanced search for critical comments and comments can be marked  
(and exported) as being critical “Mark for being critical”, “Mark 
comments in current set as being critical…”.

• In the ‘Edit Mode: Standard’ view the author or RE originally assigned 
to be responsible for a comment is now shown in the bottom left 
corner of the respective pane (changed responsibilities can be 
resolved in the History mode as these responsibilities server there 
also as buttons)

• Mac users can now use the app Preview as the PDF reader
• Offers a new menu command “Omit the clipboard listed (comma 

separated)” next to “Find by clipboard list (comma separated)” for easy 
identification of differences between comment sets

• The current set can be sorted by RE priority
• Introducing two new important preferences for constraining searches 

in all menu commands from submenu ‘Comments -> Show 
comments’. The first preference controls whether to constrain 
searches to the ‘preferred chapter’ or not. The 2nd preference controls 
whether to constrain searches within the current set or not. At the top 
of the “show comments” commands are shown the current settings for 
this first preference: Either you see there ‘within entire data base’ (all 
constraining off), ‘within current set’ (constraining within current set 
regardless of preferred chapter), ‘for <preferred chapter>’ (all 
comments pertaining to the preferred chapter), or ‘for <preferred 
chapter> within current set’ (constraining to preferred chapter as well 
as within current set). Choosing that menu command cycles through 
all 4 combinations of settings. Both preferences can also be controlled 
from the layout ‘RCtool Settings’.

• New powerful commands submenu ‘Comments -> Show comments’: 
“Show comments with the author decision…”, “Show comments with 
the RE priority…”, and “Show comments with the RE evaluation…”. 
Then can not only search for comments with a specific author 
decision, RE priority, or RE evaluation, respectively, but can also 
calculate overall statistics 

• More tool tips with improved explanations
• The FileMaker version shows a list of the currently shown chapters in 

the bottom status bar
• Submenu ‘Pro -> Scripts -> Resolve conflicts’ has been renamed to 

‘Pro -> Scripts -> Manage data base’ for hopefully more clarity what to 
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expect under this submenu as these commands do not only support 
resolving conflicts but allow to generally manage the RCtool data base

• Enhancing and polishing the behavior of commands from submenu 
“Comments -> Find comments” to be more user friendly and more 
flexibly finding comments, e.g. by offering a new command 
“Comments -> Find comments -> by special criteria...” while 
deprecating the command “Comments -> Find comments -> with 
implications for the entire report”

• Several new helper commands: “Finalize Author Responses for 
current set…”, “Finalize RE Annotation”, “Finalize RE Annotations for 
current set…”, “Set RE Evaluation to 'Yes'”, “Set missing RE 
evaluations to 'Yes' for current set…” (renamed from previously rather 
unclear “Autoenter RE evaluation for current set”)

• Commands such as “Set missing RE evaluations to 'Yes' for current 
set…” offer an option to process the current set only up to the current 
record

• Finalization of Author Responses or RE Annotations is now to be done 
for all comments before generating a final spreadsheet for publication. 
Thanks to this approach the latter spreadsheets can then be 
generated regardless of the presence of a history within Author 
Responses or RE Annotations, respectively.

• The quarantine layout for Author Responses and RE Annotations 
offers a new button “Delete some…” and shows the current record 
number (as needed by that button) in the bottom status bar.

• Quarantine import and use algorithms were improved significantly for 
more robust handling of spreadsheet shared with colleagues

• Pro users can activate a debugging mode to facilitate remote support
• Many bug fixes with respect to importing and exporting data, finding 

records, making backups, controlling Pro Mode, setting the preferred 
chapter and many more minor bug fixes and polishing of the user 
interface were done

• Many figures in the documentation do not yet show the renaming to 
from ‘REtool’ to ‘RCtool’ or may otherwise not yet fully reflect some 
changes in menus and submenus or command names. Always read 
‘RCtool’ in those figures, notably screenshots, for ‘REtool’.

• 1.9! Version 1.9 contains following improvements
• New simplified menus by offering only those commands that are 

relevant to the current role of the user (RE, Author, Other)
• New menu command ‘Find comments by who made changes…’
• Full support for AR6 WGI (FOD ≥ b8) and SROCC (≥ b10) and 

enhanced support for SRCCL
• More options for jumping to PDF’s on Macs (≥ b10)
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• Improved finding of comments by section ranges (menu ‘Comments -> 
Find comments -> for a section/section range…’) (≥ b10)

! and following bug fixes:
• Fixed menu command ‘Find comments by responsibility...’ for review 

stage ALL from submenu ‘Comments -> Find comments’ (≥ b1)
• Bug fixes for jumping to PDF’s on Macs (≥ b9)
• Bug fixes for finding comments by section ranges (menu ‘Comments 

-> Find comments -> for a section/section range…’) (≥ b10)

• 1.8.2! Version 1.8.2 contains following improvements
• New menu commands for author histories that show comments with or 

without the flag ‘Author Response finalized’
• New and more logically arranged menu commands in Pro submenu 

‘Import data’ for greater convenience 
• New menu commands that are useful when discarding a just made 

import that turned out to be bad in Pro submenu ‘Resolve conflicts’
• Pro menu ‘Pro -> Scripts -> Resolve conflicts -> Search for problems 

in REEtool data base’ detects and reports now also on orphaned 
Author Responses and/or RE Annotations as may result from 
incomplete imports when using an ‘... import from any ...’ command

• The guide has been significantly extended once more by sections 
«Importing data via Pro mode» and «Check internal consistency of 
your REEtool data base».

! and in addition following bug fixes:
• Restoring of Author Responses and RE Annotations from a 

spreadsheet
• For review stage ALL the commands from submenu ‘Comments -> 

Show comments’ fixed

• 1.8.1! Version 1.8.1 is very similar to 1.8. These are the changes:

• Importing spreadsheets from collaboration into the quarantine can now 
also be selected with the standard file selection dialogs and the drag 
and drop technique is deprecated.

• The guide has been updated accordingly.
• Minor improvements and a few bug fixes.

• 1.8! Version 1.8 is similar to 1.8fc12 to fully implement the design for the entire 
AR6 cycle till the SYR. It brings more user friendliness and stability 
including following:
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• New user interface under Windows for restoring and updating. The 
implementation for Windows is now at par with and identical with the 
behavior offered on the Mac.

• Polished and detailed informing of the user during importing, restoring, 
or updating

• Elements of the user interface offer now pop-up help texts when 
hovering over them

• Fully consistent handling of duplicates during all imports and 
commands to otherwise resolve possible inconsistencies in a REEtool 
data base

• Numerous bug fixes including the opening of the guide via the Help 
menu

• Further enhancements of the guide by new sections such as 
«Analysing Comments» and a more detailed description of the 
handling of redundant duplicates and other more technical data base 
issues

• 1.8fc12! Version 1.8fc12 represents a major step towards fully implementing the 
design of REEtool for the entire AR6 cycle till the SYR. This includes 
following:

• Extending the support for latest Author Responses for SROCC and 
SRCCL. 

• Major revision of sharing data (exporting, importing). This includes an 
effort to standardize the format of the spreadsheets used for sharing 
data. 

• New simplified menu structure reflecting the latter philosophy. 
• Full and orthogonal support for authors and REs. 
• Many improvements and substantive enhancements, including 

numerous bug fixes. 
• First time completion of the guide, which now also explains team 

collaboration for authors and REs. 
• For TSUs this version now offers a feature to generate a spreadsheet 

for publication of comments with the Author Responses. The latter is 
of particular relevance for Review Comments that have received 
multiple Author Responses to the same comment, as this is typically 
the case for entire report comments. The author history fully supports 
the reviewing and editing of such Author Responses. The spreadsheet 
REEtool can export at the end of such editing is in a format that fits the 
needs of the IPCC secretariat for the final publication of the Review 
Comments together with the Author Responses.

• 1.8fc11! Extending the support for latest Author Responses for SR1.5. A few bug fixes 
(export core data error handling; export to PDF).

•
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• 1.8fc10! Added as a new feature menu command ‘Helpers -> Enter page and line 
numbers for comparison draft...’ that allows manual entry of page and line 
numbers for a matching passage in the comparison draft. The matching 
passage as listed in the TOC meta data is now shown in comparison 
section field. Extending the support for latest Author Responses for SR1.5. 
Several bug fixes (imports of Review Comments for SRCCL, Author 
Responses SR1.5 and SRCCL) and polishing.

•
• 1.8fc9! Added new feature to produce a comments spreadsheet for a RE colleague 

who prefers not to work with REEtool but wants to use just that 
spreadsheet. The generated spreadsheet once filled out with RE 
Annotations can then be reimported into REEtool and merged with RE work 
as done within REEtool. The File menu was restructured accordingly and 
should be better to understand intuitively. Many bug fixes and improvements 
in terms of compatibility with latest TAT. REEtool-textlinks was modified too.

• 1.8fc8   First release of REEtool for Windows systems that requires not a FileMaker 
license.  Added full support for CCPs and CCBs and improved the working 
with SPMs.

•
• 1.8fc7   !Various bug fixes and improvements on usability by introducing the REEtool 

work folders and TAT-textlinks folder.
•
• 1.8fc6   !First public release of REEtool via the new REEtool home page.
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